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1. INTRODUCTION  
 

1.1 A WARM WELCOME 
Welcome to AeroQuad! This particular tutorial will focus on providing all the necessary information for 
a “start from scratch” build of an Arduino based quadcopter, referred to as an AeroQuad. It will be based 
on the recommended parts list already available on the AeroQuad website here 
http://aeroquad.info/bin/view/Main/PartsList_v2. However, since there are differences in views on how 
to deal with the frame part of the build (buying vs. building), building a frame will not be covered in this 
tutorial. A few suggestions of what a frame should have will be made.  
 

1.2 SAFETY WARNING 
Though there are not many questions about this and it is not mentioned much until something goes 
wrong, I feel it is my duty to mention this. The motors and propellers used here are not something to be 
joked around with. They are dangerous moving parts that can do some serious cutting and chopping 

damage if you are not careful. Under no circumstances are you to put the propellers on 
the motors until everything is checked out and tested to be working. This is something 
that can turn a nice day into something horrible, such as an emergency room visit or worse, so please be 
aware, and please do all your testing outside, away from people as well.  The author of this tutorial will 
not be held responsible for any damage or injury done to or by the user. Please use safe engineering 
practices and common sense when working on such projects.  
 

1.3 A SMALL NOTE 
This tutorial was started on February 15, 2010 and was meant to help out the beginners in the AeroQuad 
community. Remember, in order to stay up to date, read and ask your questions in the AeroQuad support 
forum at www.aeroquad.info in the “Support Forum” link on the left. Good luck, stay safe, and have fun 
with your build.  
 
 

2. SHOPPING LIST 
 

2.1 RECOMMENDED PARTS 
 

Priority 1 - recommended Arduino board (x1) 
    5 DOF IMU (x1) 
    IXZ500 dual axis gyro (x1) 
    AeroQuad shield (x1) 
Priority 2 – can pick other Motors (x4 plus 1-2 spares) 
    ESCs (x4) 
    Battery (x1) 
    Counter rotating propellers (2 pairs, plus spares) 
    Radio system (x1) 
    Miscellaneous  
Priority 3   Battery charger 

Power supply 
     Battery monitor/buzzer 
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PRIORITY 1 – these parts comprise the command center of the quadcopter and are the Arduino 
(Duemilanove in this case), the gyro and accelerometer sensor boards, the AeroQuad shield, the female 
headers, the breakout pins. The Arduino is the computer controller which will do all the calculations for 
stability and control. A USB A to B cable is necessary when uploading the code to the Arduino from the 
PC. The gyros are for sensing rotational motion around the three axes (x y z) and the accelerometers are 
for sensing linear acceleration about those same axes. The 5DOF IMU has a dual axis gyro and a triple 
axis accelerometer. The IXZ500 board has a dual axis gyro of which only one will be used to add the 
sixth degree of freedom to the IMU. The 
AeroQuad shield is a small green circuit board 
to which the sensors are soldered to and which 
then connects directly on top of the Arduino 
through pins. It eliminates the need to have a 
breadboard and lots of loose wiring.  
 
      Arduino Duemilanove with ATmega328 
      Price: $30 
      Where: AeroQuad shop 
 

5 DOF IMU     
Price: $75    
Where: AeroQuad shop  

 
 
 
 
        IXZ500 Dual Axis Gyro 
        Price: $40 
        Where: AeroQuad shop

                    
AeroQuad Shield v1.6.1 
Price: $25       
Where: AeroQuad shop     

   
    Stackable Female Headers (Duemilanove pack) 
    Price: $5 
    Where: AeroQuad shop 

 
 
 
 
 
 
 
 
 
 

 
Breakout Pins (straight) 
Price: $2.50 
Where: AeroQuad shop 



3 

PRIORITY 2 – these components include the motors, motor electronic speed controllers (ESCs), the 
main battery, the counter rotating propellers, the radio system and other, miscellaneous things. The 
ESCs control the brushless motors. The female-female servo extension cables are used to connect the 
radio receiver channels to the shield. The 3mm male/female bullet connectors are used to connect the 
ESCs to motors and also to the main power distribution line. Finally, the 18 gauge (no thicker than 16 as 
that will add unnecessary weight) wire is used to make the main power line, splitting the battery’s output 
in a parallel fashion for the four motors/ESCs.   

      Hacker Style 20-22L motor 
TowerPro 2410-09 motor   OR  Price: $16 ($64 for 4) 
Price: $6.40 ($26 for 4)     Where: HobbyKing 
Where: HobbyKing    

     
 
 

Turnigy Plush 18 amp ESC 
Price: $11.50 ($46 for 4) 
Where: HobbyKing 

 
 
 
 
EPP1045 Counter Rotating Prop pairs   
Price: $4.50 ($9 for two pairs)     OR APC1047 Counter Rotating Prop pairs 
Where: QuadroUFO (direct links available)  Price: $8.50 ($17 for two pairs) 

 Where: AeroQuad shop 
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Zippy Flightmax 4400mAh 11.1v 15C lithium 
polymer battery pack 
Price: $21 
Where: HobbyKing 

 
    Servo Extension Cables (female to female) 
    Price: $8 (for 6) 
    Where: AeroQuad shop 

Spektrum DX7 radio with AR6200 receiver (or 
AR7000 shown) 
Price: minimum new $280 w/AR6200 (eBay) 
Where: online, local hobby shop 
 
   
3mm Bullet Connectors (for motors & ESCs)   
Price: $4.50 ($9 for 2 packs, 20 pairs total)  18 gauge wire (2-3 ft)   
Where: eBay (seller: rctimer)    Price: ~$6  

             Where: RadioShack, local hobby shop, online 
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PRIORITY 3 – These items include a good battery charger with a power supply and a battery voltage 
monitor or buzzer. They are not necessary for the flight of the quad, but obviously are needed for 
charging the battery and making sure that the battery is not discharged below recommended levels. 
Many different choices are available in 
this priority and the known and tested ones 
are shown. The HobbyKing battery 
monitor requires some minor soldering 
while the one on eBay comes ready to use.  
 
 

Turnigy Accucel-6 50W 
5A Balancer/Charger 
Price: $25 
Where: HobbyKing 

 
 
 
 
 
 
 
 
 
 
 

12v 5A Power Supply 
Price: $10 
Where: HobbyKing 

 
 
 
 
 
 
Lipo Battery Low Voltage Buzzer Alarm OR Hobby King Battery Monitor 3S 
Price: $4      Price: $4 
Where: eBay (seller: goodlucksell)   Where: HobbyKing 
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2.2 TOOLS FOR THE JOB 
Some of the tools necessary for the build include the soldering irons necessary for soldering of the 
sensors to the pins and to the shield, soldering female headers to the shield, and finally soldering all the 
bullet connectors to the motors, ESCs, and main power line. It is very important to use a low power 
soldering iron, such as a 15 watt iron (no higher) for all the sensor and shield soldering. The rest 
(connectors, etc) can be done with a higher power iron, such as a 30 watt one. An obvious necessity is 
then the solder. A 0.032” thick rosin core solder is ideal for the sensors job and a thicker one, such as 
0.062” thick, is preferred for the other tasks.  
 
 
15 watt soldering iron 
Price: <$10 
Where: RadioShack, online, other 
 
 
 
 
 
30 watt soldering iron 
Price: <$10 
Where: RadioShack, online, other  
 
 
 
 
 
 
 
0.032” rosin core solder    0.062” rosin core solder 
Price: <$10      Price: <$10 
Where: RadioShack, online, other   Where: RadioShack, online, other 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 



7 

3. THE BUILD 
 
After obtaining all the necessary and recommended components, it is now time to start the build. This 
part of the tutorial covers the installation of the software, establishment of an Arduino to PC link, 
soldering tasks for the sensors and connectors, putting everything together, testing the radio and 
calibrating the ESCs, connecting and testing everything, and finally making the maiden flight. 
 

3.1 DOWNLOADS 
 
http://arduino.cc/en/Main/Software Download the Arduino IDE for your operating system. The latest 
version right now (February 19, 2010) is the 0018 version. An older, tested and stable version is the 
0015 version and is available in the same link under “Previous IDE Versions.” The Arduino IDE is an 
environment for developing and editing code, including the AeroQuad code. The IDE package should 
come with the necessary USB drivers. Install it.  
 

http://code.google.com/p/aeroquad/downloads/list  Download the AeroQuad code. The AeroQuad 
code is the code which controls the quadrotor. It is uploaded into the Arduino through the Arduino IDE. 
Currently (February 19, 2010), the latest code available is the AeroQuad_v1.6b which is a beta version 
of the older v1.5/v1.4 and has some fixes. Unzip it into a folder. (Later, when opening the AeroQuad 
code in the Arduino IDE, the file from the unzipped AeroQuad folder which needs to be opened is the 
AeroQuad.pde file.) 
 

http://code.google.com/p/aeroquad/downloads/list  Download the AeroQuad Configurator_V2.1 
(now available for both Windows and Mac OS). The Configurator is a very useful tool when configuring 
and troubleshooting the quad. It has displays and commands for motors commands, sensor outputs, PID 
settings, transmitter/ESC calibration, and much more. Install the Configurator.  
 

3.2 ARDUINO-PC INTERFACE 
 
If you are completely unfamiliar with the Arduino, this part of the tutorial should provide information on 
how to establish a connection between the computer and the Arduino.  

1. Open the Arduino IDE and then the Blink tutorial through File>Sketchbook>Examples>Digital>Blink 
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2. Connect the Arduino to the PC through the USB A to B cable. The USB provides power to the 
Arduino automatically and thus an external power is not required, but can be connected anyway.  

3. Select the correct Arduino board through Tools>Board>Arduino Duemilanove w/ATmega328 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Select the correct USB serial port through Tools>Serial Port. If uploading fails, then the wrong 
serial port (USB) is selected. Select another one if this message pops up during uploads.  
 
 
 
 
 
 
 
 
 
 

5. Upload the Blink sketch (code) to the Arduino. Upon a successful upload, the message below 
should show “Done Uploading.” 

6. This Blink tutorial sketch makes the LED next to digital pin 13 on the Arduino blink on and off in 
a loop, one second at a time by default. Congratulations, you’ve uploaded your first sketch to the 
Arduino. 

 
When satisfied with the LED, it is now time to upload the AeroQuad code in a similar manner.  

1. Open the AeroQuad code through File>Sketchbook>Open.  
2. Find the AeroQuad folder and select the AeroQuad.pde file. This will open the complete 

AeroQuad code with all the tabs.  
3. Hit upload to upload it to the Arduino.  
4. After a successful upload, the Arduino may be disconnected from the computer.  
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3.3 SENSORS AND SHIELD – SOLDERING 
 
The next step is to solder the sensors to the shield to make a single-piece six degrees of freedom inertial 
measurement unit (IMU). This requires some precise soldering which needs to be done carefully using 
the aforementioned 15 watt soldering iron and the 0.032” rosin core solder.  
 
Before soldering, here’s the complete set of components for the IMU. Included in the picture is the 
shield with capacitors, LED, resistor and diode, the stackable female headers (Duemilanove pack), the 
short-pinned female headers (for sensors), the breakout pins (52 total), and the two sensor boards. In this 
case, the shield (v1.6.1) comes as a kit and requires all the components to be soldered by the user. 
 

 
 
 
A note on electrostatic discharge (ESD) 
It is important to take some care when working with the electronics (sensors and the Arduino) in order to 
prevent them from being damaged by ESD. Here are some recommendations: 

 Ground yourself before touching the electronics. This can be done by touching a metal appliance 
which is plugged into an electrical socket. 

 Work in an environment where there is less chance of ESD developing, such as on a concrete 
floor of a garage 

 Avoid carpets and plastic tables 
 When not in use, store the electronics in an ESD plastic bag.  
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Breakout pins to the sensor boards 
1. Break off a chunk of the breakout pins, two pieces of nine pins and one piece of four pins.  
2. Insert the breakout pins to the hole slots of their respective sensor boards. Insert them from the 

bottom of the sensor boards (side with no circuitry) using the short end of the pins, like below. 
Also make sure not to break the pins individually but rather in groups, two of 9 and one of 4.  
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3. Fix the pins to the sensor board so the pins are vertical to the board or have someone help. 
4. Heat the 15 watt iron for at least 5 minutes 
5. Solder the pins to the breakout board. Making sure that the pins and the board do not move, 

apply heat for about 1 second to both the round metal pad on the sensor board and the pin 
sticking out of it (simulateneously), then immediately apply the solder either onto the pad very 
close to the iron or onto 
the tip of the iron. Make 
sure not to touch the 
adjacent pads as that will 
short them and render the 
board useless. Also, after 
soldering the first pin, 
double check that the pins 
are vertical and flush with 
the board. If not, heat that 
first pin and carefully 
attempt to straighten out 
the pins.  

6. Repeat this for all of the 
22 pins (13 on the 5DOF 
IMU board and 9 on the 
IXZ500 board) 
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Stackable female headers (Duemilanove pack) to the shield 
This step involves soldering the stackable headers (the ones bought separately from the shield) to the 
shield. This will allow the shield to be mated with the Arduino through the pins easily. There are a total 
of five pieces which need to be soldered, four on top and one from the bottom. Two are 6-pin, two are 8-
pin, and one is a special piece having 2 rows of 3 pins. 
 

1. Start with the 6 or 8 pin pieces, soldering them with the same care as the sensor boards. Insert the 
6 and 8 pin pieces from the top of the shield so as to have the black plastic headers on top and 
the pins sticking out from the bottom. They must be inserted into the outermost pins (see picture) 
in order to then fit the Arduino properly. 

2. Solder the 6 and 8 pin pieces from the bottom, making sure they are all sticking out vertically 
3. Insert the 2x3 piece from the bottom so as to have the metal pins coming out from the top side 

and the black headers being on the bottom side.  
4. Solder the 2x3 piece to the shield 
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Motor and receiver pins to the shield 
These breakout pins are soldered to the 
shield in order to allow for connections 
from the motor ESCs and the receiver 
channels to the shield.  
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LED, resistor, and diode to the shield 
These are simple to install and solder. 
First insert the LED, making sure that the 
polarity is respected. One side of the LED 
is flat and the spot on the shield for the 
LED has a round mark with one side being 
flat. The LED’s flat side should face the 
words “…shield v1.6.1”. The diode should 
be inserted in the similar manner, having 
one flat size. Finally, the resistor has no 
polarity and may simply be inserted. 
Solder the three components from the 
bottom and trim off the extra wires.  
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Capacitors to the shield 
Insert the capacitors from the top and solder them from the bottom. The capacitors have a polarity which 
must be followed. Both the shield and the capacitors are clearly marked for polarity.  
 

 
 
 
 
 
 
 
 
 
 
Sensors to the shield 
The final step is to solder the sensors (which already have the breakout pins soldered to them) to the 
shield. There are two options for this step. One is to solder the sensors directly to the shield through the 
breakout pins that they already now have. With this option, the sensors are permanently soldered to the 
shield. The second option is to first solder stackable female headers (the short-pinned ones) to the shield 
and then connecting the sensors to the shield through them. The second option thus allows the sensors to 
be removed if necessary to be used on another shield or another project.  
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OPTION 1 
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OPTION 2 
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3.4 POWER DISTRIBUTION GRID 
 
This part of the quad includes the wiring which provides power to the motors. It is simple to construct 
such a power line using 18 and 16 gage wires, the 3mm bullet connectors, a connector compatible with 
the one on the battery, and an optional simple switch. The main branch which connects to the battery 
should be a little thicker, thus 16 gage, while the other 4 (or 5, if using main battery to power Arduino) 
branches can be thinner using the 18 gage wire. The main branch should have a 4mm bullet connector 
with protector (identical to the one on the battery). Solder all the 3mm bullet connectors to the motors, 
ESCs, and the power line wires. The motors and the battery side of the ESCs should have the bullet 
(male) connector. The motor side of the ESCs and the power line wires should have the female 
connector. The switch should be somewhere along the main branch so as to control all power at once. 
Once again, this soldering task can be done using the 30 watt iron and thicker solder.  
 
Here’s an example of a simple power line, although this particular one has JST connectors at the ends of 
the 4 branches instead of the female bullet connectors. This particular power line is for a light quad, 
using 20 gage wires, and will not take too much current on the individual branches.  
 

 
 

An important thing to remember when making the power line is to consider the frame and its dimensions 
in order to make the power line fit into the frame without any problems, such as interfering with other 
components.  
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Arduino power source 
Although using the main battery for providing power to the Arduino is fine, it is recommended to use a 
separate battery, such as a small capacity 7.4v Lipo, to do so. This will ensure a clean power source for 
the Arduino and also reduce the heat generated by its onboard voltage regulator. A good such battery is 
the Rhino 610mAh or 460mAh 7.4v Lipo from HobbyKing, each costing around $4.  
 

  
 

It is also highly recommended to solder a female JST connector directly into the Arduino power-in jack 
(or rather in the back of it). This will eliminate the need for using a 2.1mm center positive plug and will 
allow for a direct connection to a battery such as above.  
 
 

3.5 TEST RADIO AND CALIBRATE ESCS 
 
The next step is to test the radio. Some radio systems, such as the Spektrum 2.4GHz ones, require the 
binding of the receiver to the transmitter. Follow the instructions provided by the manufacturer and 
make sure that the radio system is working. This can be done by simply connecting a motor to an ESC 
and the ESC to the throttle channel of the receiver. If it is possible to run the motor, then the radio link is 
operational.  
 
After making sure that the radio system is working properly, it is now time to calibrate the ESCs. The 
calibration is basically teaching the ESC the range of thrust (lowest and highest power to give the 
motors so to say). It will assure equal motor startup later on. The ESC calibration must be done using 
the same radio system that will be used on the quadrotor and done individually for each ESC. To 
do the calibration on the recommended Turnigy Plush 18 amp ESCs, follow the given steps (these are 
also provided in the Turnigy ESC instruction manual): 
 

1. Connect the ESC to the throttle channel of the receiver. Have a motor connected to the ESC as 
the motor will provide beeps necessary to hear the calibration steps. DO NOT attach the 
propeller or anything else to the motor; simply have the motor connected to the ESC.  

2. Turn on the radio and put the throttle stick to maximum position 
3. Now connect the ESC to the battery 
4. The motor should beep a 1 2 3 beep followed by two short beeps. Immediately after the two 

short beeps, put the throttle stick down all the way, the motors should make 3 short beeps 
(representing the 3 cells of the battery) and then finally make a 1 long beep, indicating that the 
throttle range has been set (calibrated).  

 
“Calibrating all four ESCs together” method 
There is also a second method for calibration of the ESCs (mentioned on page 15 in section 3.8, “Test 
and Configure Everything”). This method is done through the use of the Configurator by following its 
given instructions. 
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3.6 PUT EVERYTHING TOGETHER 
 
This step is not discussed in detail as it involves the construction of a frame, which is completely up to 
the user. However, some recommendations regarding the construction of a frame are made. A ready to 
order frame known by many users at the AeroQuad forum is the “Rusty’s frame” - it is not discussed 
here but simply mentioned for the sake of awareness.  
 
A good frame should have the following: 

 Landing gear – for medium to larger sized quads (1 kg and over) the T-Rex 600 helicopter 
landing gear set can be used. These can be obtained online or from a local hobby shop for around 
$15 for the complete set. For smaller quads, such as under 1kg, the smaller T-Rex 450 helicopter 
landing gear set can be used, costing around $10.  

 A housing for the electronics – the electronics housing can be anything from an aluminum cage 
consisting of two strips of aluminum covering the electronics to a full pledged box of some sort. 
A good place to start is to use a styrofoam faucet cover, which provides a smooth, lightweight, 
and strong protective cover. The housing is there to protect the electronics from crash damage, 
such as flips and falls, as well as the elements when it is stored.  

 Battery compartment – this part is a little trickier, but with some work, can be made very 
effectively. A recommended design is to use Velcro underneath the belly of the quad, 
incorporating it into the structure of the quad. This will provide a strong battery compartment 
while still allowing for an easy battery removal and replacement in the field.  

 Arm extensions – these can be used to ensure safer operation of the quad, especially during first 
test flights or experiments. The arm extensions could simply extend beyond the propeller length 
or they can also protrude upwards, thereby providing protection for the motors and propellers 
during flips.  

 
Motor-to-motor distances 
Which motor to motor distance to pick is perhaps one of the most widely asked question in the quadrotor 
community. The simple answer is that there is no one best distance, unless talking about one particular 
quadrotor with all its dimensions and specifications known. Here’s some information regarding the 
motor-to-motor distances: 

 Generally, the larger the distance between the motors, the more stable is the quad. The shorter is 
the distance, the quicker is the quad to respond. In other words, a larger armed quad will have 
slower response times to movements and a smaller armed one will be able to make agile 
movements and acrobatic maneuvers. Most aerial video and photography quads will tend to have 
larger distances than those for acrobatics.  

 A good motor distance to start with is around 60cm. This however, depends totally on what the 
user wants.  

 The motor distances should be made identical as accurately as possible 
 

X versus + configuration 
This refers to the configuration of the frame. In the X configuration, the quad has two motors on each 
of the four sides, while still having 4 motors total. Weird? Not really. This simply means that the front of 
the quad is between two of the front motors, the rear between two of the rear motors, and so on. In the 
plus configuration, the location of the front is simply the front motor, the rear is the rear motor, and so 
on. The plus configuration is generally the more common for beginners. The X configuration is more 
useful for aerial photography where the camera needs to be positioned as close to the center of the frame 
as possible while still having an open view.  
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The first image above shows the plus (+) configuration in which the motor ESCs are connected 
normally: the right motor ESC is connected to the “Right” motor pins on the shield, left motor ESC to 
the “Left” motor pins, and so on. The second image (on the right) shows the X configuration in which 
each of the four sides (front, rear, right, and left) have two motors and must be connected as depicted.  
 
Arduino orientation 
The correct way to secure the Arduino (which also has the 
shield and the sensors on top of it) is to have the USB 
connector side of it representing the rear side of the quad.  
 
 
 

3.7 CONNECT EVERYTHING TOGETHER 
 
The next step is to simply connect all the electronics together, 
after mounting them to their respective locations of course. DO NOT install the propellers yet.  
 

 Motors should be clamped, bolted, or otherwise secured to the arms.  
 The ESCs should be connected to the motors and also secured either on the arms, inside the arms 

if large enough (though not recommended for head dissipation issues), or inside of the 
electronics housing/box. The ESCs should also be connected to the main power line.  

 The Arduino and all its components (shield, sensors, etc) should be secured at the center of the 
frame. It is common for beginners to use mounting tape or even scotch tape to secure their 
electronics. This is not a good practice as all those things will loosen and induce vibrations and 
instability. A good thing to do is to use bolts and nuts.  

 The shield should mate onto the Arduino and also have the receiver channels connected to it 
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3.8 TEST AND CONFIGURE EVERYTHING 
 
These next steps are critical to ensure the correct operation of the quad. Once again, still DO NOT 
install the propellers yet.  
 

1. Connect the now wired up AeroQuad to the Configurator on the PC. If using Windows Vista, run 
the configurator in Administrator mode. If connection does not work, select a different port.  

2. In the rightmost flyout, select the Initial Setup option and then click on the blue “Initialize 
EEPROM” icon. This will write default values for PIDs and all the other factors into the Arduino 
EEPROM memory.  

3. Then click the “Calibrate Transmitter” icon and follow the steps provided in the Configurator to 
do so. If using the recommended Spektrum DX7 radio with AR6200 receiver, then there should 
be no problems.  

4. Using the “Calibrate ESCs,” it is possible to calibrate all four ESCs together. Follow the 
instructions provided in the Configurator under the “Calibrate ESCs” icon. Using the ESC 
calibration feature of the Configurator is potentially dangerous unless all the steps are read and 
followed carefully. Once again, DO NOT have the propellers installed yet. 

5. Next, follow the 13 steps of the Pre-Flight Checkout list (taken from AeroQuad website) 
 
The Pre-Flight Checkout list (follow carefully) 
In the Flight Configuration tab of the Configurator, select the Motor Bar Plot from the bottom most 
flyout and follow these steps: 

1. Arm the motor output by moving the throttle stick to the lower right. Increase the throttle to 
50%.  

2. By hand, roll the AeroQuad to the left. The left motor command should increase. The right 
motor command should decrease.  

3. By hand, roll the AeroQuad to the right. The right motor command should increase. The left 
motor command should decrease.  

4. By hand, pitch the AeroQuad down (the front motor should be lower in position than the rear 
motor). The front motor command should increase. The rear motor command should decrease.  

5. By hand, pitch the AeroQuad up (the front motor should be higher than the rear motor). The rear 
motor command should increase. The front motor command should decrease.  

6. By hand, rotate the AeroQuad clockwise. The front and rear motor commands should increase 
(assuming the motors are wired to rotate in the clockwise direction).  

7. By hand, rotate the AeroQuad counter-clockwise. The left and right motor commands should 
increase in value (assuming the motors are wired to rotate in the counter-clockwise direction).  

8. Using the transmitter, move the roll stick to the left. The right motor command should increase. 
The left motor command should decrease.  

9. Using the transmitter, move the roll stick to the right. The left motor command should increase. 
The right motor command should decrease.  

10. Using the transmitter, move the pitch stick forward. The rear motor command should increase. 
The front motor command should decrease.  

11. Using the transmitter, move the pitch stick back. The front motor command should increase. 
The rear motor command should decrease.  

12. Using the transmitter, move the yaw stick to the left. The front and rear motor commands 
should increase.  

13. Using the transmitter, move the yaw stick to the right. The left and right motor commands 
should increase.  
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Finally, repeat the above steps, but this time check the responses of the actual motors and cross-
check them with the responses of the motors in the Configurator. The virtual motors in the 
Configurator and the actual motors should have the same (correct) responses.  

 

 
3.9 MAIDEN FLIGHT 
 
After completing the quad and double and triple checking that everything works, it is now time to test it 
out. To assure safety, it is wise to test fly the quad in an open field, as far away from people as possible, 
the operator included.  
 
It is now time to put on the propellers. Remember, the front and rear motors spin clockwise when 
looking from above, thus they need the clockwise propellers and the right and left spin counterclockwise 
when looking from above. If any of the motors are spinning the wrong way, then the only thing that 
needs to be done is to swap any two of the three motor/ESC wires of those particular motors. From 
this point on, the quad is potentially a very dangerous machine and must be handled with extreme 
caution.   
 
After attaching the propellers, turn on the Arduino and the main power. The motors are armed by 
bringing the throttle stick to the lower right and disarmed when on lower left. Step back, arm the motors, 
and apply thrust slowly. Be cautious and apply thrust slowly at first to assure that all the motors are 
spinning equally. Take off, hover, and learn to fly. Good luck! 
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4. LINKS TO PARTS 

 
Arduino Duemilanove 

http://carancho.com/AeroQuad/store/  (AeroQuad shop) 
5 DOF IMU 

http://carancho.com/AeroQuad/store/  (AeroQuad shop) 
IXZ500 Dual Axis Gyro 

http://carancho.com/AeroQuad/store/  (AeroQuad shop) 
AeroQuad shield v1.6.1 

http://carancho.com/AeroQuad/store/  (AeroQuad shop) 
Stackable female headers 

http://carancho.com/AeroQuad/store/  (AeroQuad shop) 
Breakout pins 

http://carancho.com/AeroQuad/store/  (AeroQuad shop) 
TowerPro 2410-09 motors 

http://hobbycity.com/hobbycity/store/uh_viewItem.asp?idproduct=5111 (HobbyKing) 
 Hacker Style 20-22L motors 
http://hobbyking.com/hobbyking/store/uh_viewItem.asp?idproduct=4700 (HobbyKing) 

Turnigy Plush 18 amp ESCs 
http://hobbycity.com/hobbycity/store/uh_viewItem.asp?idproduct=4312 (HobbyKing) 

Zippy Flightmax 4400mAh 11.1v 15C battery 
http://hobbycity.com/hobbycity/store/uh_viewItem.asp?idproduct=6504 (HobbyKing) 

EPP1045 counter-rotating propellers set 
www.quadroUFO.com (QuadroUFO) 

APC1047 counter-rotating propellers set 
http://carancho.com/AeroQuad/store/  (AeroQuad shop) 

Female-female servo extension cables 
http://carancho.com/AeroQuad/store/  (AeroQuad shop) 

Spektrum DX7 Mode 2 radio with AR6200 receiver 
eBay (seller: gotheli) or local hobby shop or http://www.toddsmodels.com/default.asp (Todd’s Models) 

3mm bullet connectors 
eBay (seller: rctimer) 

18 and 16 gage wire 
RadioShack, other 

Turnigy Accucel-6 balancer/charger 
http://hobbycity.com/hobbycity/store/uh_viewItem.asp?idproduct=7028 (HobbyKing) 

12v 5A power supply 
http://hobbycity.com/hobbycity/store/uh_viewItem.asp?idProduct=6256 (HobbyKing) 

Battery voltage alarm 
eBay (seller: goodlucksell) 
http://hobbycity.com/hobbycity/store/uh_viewItem.asp?idproduct=7223 (HobbyKing) 

15 watt soldering iron 
RadioShack, other 

30 watt soldering iron 
RadioShack, other 

0.032” solder 
RadioShack, other 

0.062” solder 
RadioShack, other 
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610mAh Arduino battery 
http://hobbycity.com/hobbycity/store/uh_viewItem.asp?idproduct=7305 (HobbyKing) 

JST male/female connectors w/cables  
http://www.dealextreme.com/details.dx/sku.15234 (DealExtreme) 

Square carbon fiber 10x10x750mm tubes 
http://hobbycity.com/hobbycity/store/uh_viewItem.asp?idproduct=9012 (HobbyKing) 

4mm bullet connectors w/ protector 
http://hobbycity.com/hobbycity/store/uh_viewItem.asp?idproduct=9283 (HobbyKing) 
 


